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GII-6. GEODEZIJA IR KARTOGRAFIJA GIS SISTEMOSE 3 LABORATORINIS DARBAS 

SKLYPO DALIJIMO PLANAS 

Atlikimo terminas: Užduočiai atlikti reikia maždaug savaitės  

Praktinio darbo vertinimas: Šis praktinis darbas vertinamas iki 19 balų, jo vertė sudaro 7 proc. viso kurso 

bendro pažymio. 

 

APRAŠYMAS IR UŢDAVINIAI 

Koordinačių geometrija (COGO) – tai metodas matavimų rezultatams ar inžineriniams (techniniams) 

duomenims įvesti į GIS, CAD arba žemėlapių kūrimo programas. Šiuos duomenis galima surinkti 

standartiniais lauko matavimų būdais ir priemonėmis arba gauti iš turimų žemėlapių, brėžinių, inžinerinių 

planų ar užrašų. 

 

Šiame laboratoriniame darbe dirbsite su keliomis ArcGIS matavimų apdorojimo priemonėmis – Survey 

Analyst plėtiniu, COGO įrankių juosta ir kt. 

 

Baigę šį darbą, turėtumėte suprasti šiuos terminus ir sąvokas: 

 Geoduomenų bazė 

 Duomenų rinkinys ir elementų klasė 

 Matavimų projektas 

 COGO 

 Matavimų skaičiavimai 

 Orientavimo parametrai 

 Išmatuotas geodezinis ženklas 

 Ėjimai 

 Uždarymo klaida 

 Kompaso taisyklė 

 Nesąryšio ataskaita 

 ARC/INFO sluoksnis 

 

ATSISKAITYMO REIKALAVIMAI 

Šį dokumentą su atsakymais į visus klausimus, nesąryšio ataskaitą ir galutinę matavimų duomenų bazę su 

COGO supakuokite į vieną failą ir pateikite per Blackboard nuotolinio mokymo sistemą. 

 

PASIRUOŠIMAS 

Duomenys 

Šiam darbui reikalingus duomenis nusikopijuokite į C:\Data\ aplanke naujai susikurtą GII06_3 aplanką. 

Darbui reikalingą 7630.sid aeronuotrauką rasite C:\Data\ORT10LT\Vilnius aplanke. 

Programinė įranga 

Šiam darbui reikia ArcInfo licencijos bei ArcGIS Survey Analyst plėtinio licencijos.  

Literatūra ir elektroniniai vadovai 

 4 dalis. „Antţeminiai matavimai ir padėties nustatymas“: paskaitos tekstas ir PPT skaidrės. 

 Elektroninis ArcGIS darbalaukio ţinynas 9.2: COGO 

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?id=571&pid=570&topicname=An_overview_of_C

OGO 

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?id=571&pid=570&topicname=An_overview_of_COGO
http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?id=571&pid=570&topicname=An_overview_of_COGO
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UŽDUOTIS  

Scenarijus 
 

Klientas turi patvirtintą sklypo dalijimo planą. Planas nubraižytas ant popieriaus. Klientas nori įvesti šį planą į 

savo geografinių duomenų bazę. Bazės formatas ArcGIS failinė duomenų bazė (gdb). Duomenys turi būti 

LKS-94 koordinačių sistemoje. 

 

Matininkas išmatavo du atstumus nuo senų geodezinių ženklų iki pradinio sklypo taško (kairysis apatinis 

kampas). Šie atstumai yra 540,22 metro nuo 05-0283 geodezinio punkto ir 151,12 metro nuo 05-0282 

geodezinio punkto. Geodezinių ženklų koordinatės nurodytos Pulkovo 1942 5 zonos sistemoje ir pateiktos 

SHAPE failu. LKS-94 ir Pulkovo 1942 (SD42) koordinačių sistemos aprašytos šio darbo priede. 

 

Klientas nori COGO matavimų priemonėmis sukurti dalijimo linijas ir mazgus su mažesne negu 1 metro 

uždarymo paklaida. Galutinis terminas – birželio 18 d. 

 

Duomenų atvaizdavimas ir matavimų projekto sukūrimas 
 

Lauko matavimų duomenis paprastai sudaro taškų koordinatės, atstumai ir išmatuoti kampai; taip pat nurodomi 

taškų identifikatoriai, kartais pateikiami papildomi taškų aprašai. Duomenys gaunami ir užrašomi standartiniais 

lauko matavimų metodais, pavyzdžiui, teodolitinių ėjimų metodu arba objektų išsidėstymo matavimų serijomis. 

Duomenys gali būti neskaitmeniniai (surašyti bloknote) arba skaitmeniniai (įrašyti į kokį nors elektroninį 

tacheometrą arba duomenų registravimo prietaisą). Pastaruoju atveju duomenys bus specialia programine įranga 

persiųsti į biuro kompiuterius. 

 

Tarp turimų žemėlapių ir planų yra dalijimo planų su juridinėmis sklypų ribomis ir techniniais inžineriniais 

brėžiniais. Abiem atvejais elementai vaizduojami koordinatėmis, atstumais ir orientavimo kampais, arba 

nurodyti elementų perstūmimo atstumai. 

 

  

Išmatuotų geodezinių ženklų paruošimas 
 
ArcGIS programa galima dirbti su geoduomenų bazėse arba įvairių GIS formatų failuose (pvz., shape) saugoma 

informacija. Duomenims redaguoti ir valdyti daugiausia naudojamos geoduomenų bazės. Geoduomenų bazė yra 

įvairių tipų geografinių duomenų rinkinių sankaupa. 

 

Šiame darbe geoduomenų bazę naudosite matavimų duomenų rinkiniui sukurti. Jei norite ArcGIS programa 

sukurti kokią nors topologinę elementų duomenų rinkinių struktūrą, reikia geoduomenų bazės 

(http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=An_overview_of_the_Geodatabase). 

 

1) Atverkite ArcCatalog, sukurkite naują failinę duomenų bazę pavadinimu Matavimai ir užverkite 

ArcCatalog: 

 eikite į savo Data\GII06_3 darbinį aplanką; 

 dešiniuoju mygtuku spustelėkite GII06_3, stumkite žymeklį ant New ir spustelėkite File Geodatabase 

(failinė geoduomenų bazė); 

 GII06_3 aplanke sukuriama nauja geoduomenų bazė. Kad būtų lengviau pakeisti pavadinimą, laikinas 

pavadinimas "New File Geodatabase" (nauja failinė geoduomenų bazė) iškart yra pažymėtas. 

Pakeiskite pavadinimą: surinkite „Matavimai“ ir spustelėkite įvedimo klavišą (Enter). 

 

 

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=An_overview_of_the_Geodatabase
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2) ArcMap programa į žemėlapį įkelkite pirmąjį sluoksnį – vilniaus_m_sklypai.shp. 

 

3) Pridėkite vietinius (savivaldybės) geodezinius punktus – vilniusviePul42.shp. Pasirodžius perspėjimo dėl 

koordinačių sistemos (Coordinate System Warning) dialogui, spustelėkite mygtuką Transformation 

(transformacija). Nurodykite, kad koordinates reikia konvertuoti iš (Convert from:) GCS_Pulkovo_1942 į 

(Into:) GCS_LKS_1994 naudojant (Using:) Pulkovo_1942_To_LKS1994. Spustelėkite OK (gerai) ir Close 

(užverti). Ekrane rodomo vilniusviePul42 sluoksnio Pulkovo geografinių koordinačių sistema (GKS) bus 

dinamiškai transformuojama į LKS GKS. 

 

 
 

4) Į žemėlapį pridėkite landu_p.shp sluoksnį, sujunkite jį su lut.dbf ir pavaizduokite Vilniaus žemės 

paskirties duomenis simboliais pagal APRASAS stulpelio reikšmes. 

 

5) Dabar perprojektuosite vilniusviePul42 geodezinių punktų padėtis į koordinačių sistemą, kurios reikia 

klientui: 

 Pirmiausia nustatykite vilniusviePul42 koordinačių sistemą. 

 Pridėkite X ir Y laukus ir apskaičiuokite geodezinių ženklų X ir Y koordinates: 

 atverkite vilniusviePul42 atributų lentelę ( ), spustelėkite Options > Add 
Field (parinktys > pridėti lauką) ir pridėkite dvigubo tikslumo (Double) tipo lauką X42; 

 dešiniuoju mygtuku spustelėkite X42 lauko antraštę; tada apskaičiuokite taško X koordinatę 

duomenų šaltinio koordinačių sistemoje (Calculate Geometry > OK > X Coordinate of Point); 

 taip pat sukurkite stulpelį Y42 ir apskaičiuokite ordinates. 

 

6) ArcToolbox programos projektavimo (Project) įrankiais perprojektuokite vilniusviePul42.shp failą į 

vilniusvieLKS94 elementų klasę ir įrašykite ją į Matavimai.gdb failą: 

 Atverkite ArcToolbox standartinių įrankių juostos mygtuku . 

 Išskleiskite medį (Data Management Tools > Projections and Transformations > Feature – duomenų 

valdymo įrankiai > projekcijos ir transformacijos > elementas) ir paleiskite projektavimo (Project) 

įrankį; 

 įvesties duomenų rinkinys (Input Dataset) bus vilniusviePul42.shp; 

 raskite Matavimai.gdb ir pavadinkite išvesties klasę vilniusvieLKS94 

 importuokite išvesties koordinačių sistemą iš vilniaus_m_sklypai.shp; 

 pasirinkite Pulkovo_1942_to_LKS_1994 geografinę transformaciją (Geographic 

Transformation). 

 Įkelkite vilniusvieLKS94 iš Matavimai.gdb į žemėlapį. 
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1 klausimas. Kas yra geografinė transformacija ir kokie yra orientavimo parametrų (datum) transformavimo 

metodai? Kurį metodą naudojote jūs? 

 

 

 

 

 

2 

7) Perskaičiuokite vilniusvieLKS94 X ir Y koordinačių vertes ir palyginkite jas su koordinatėmis iš 

vilniusviePul42.shp failo. 

 

2 klausimas. Ar labai skiriasi X ir Y koordinatės vilniusvieLKS94 ir vilniusviePul42.shp elementų lentelėse? 

Pabandykite paaiškinti, kodėl. 

 

 

 

 

 

 

1 

8) Užverkite ArcMap; projekto išsaugoti nebūtina.  

Matavimų duomenų rinkinio sukūrimas 
 

Dabar jums reikės ArcGIS Surveying Analyst plėtinio, kad galėtumėte sukurti matavimų elementų rinkinį ir įkelti 

į ArcMap matavimų duomenis. 

 

ArcGIS Surveying Analyst matavimų objektus saugo matavimų duomenų rinkinyje (Survey dataset). 

ArcCatalog programa duomenų bazėje galima sukurti naują elementų duomenų rinkinį. Elementų duomenų 

rinkinys – tai susijusių elementų klasių, esančių toje pačioje koordinačių sistemoje,  rinkinys. Elementų 

duomenų rinkiniai naudojami susijusioms elementų klasėms sujungti į visumą erdvėje arba pagal temą. 

Pagrindinė jų paskirtis – iš susijusių elementų klasių sudaryti vieną duomenų rinkinį, kad būtų galima sukurti 

topologiją, matavimų tinklą, tinklo duomenų rinkinį ir kt. 

 

9) ArcCatalog programoje: 

 Spustelėkite Tools (įrankiai) ir Extensions (plėtiniai). 

 Pažymėkite Survey Analyst langelį. Plėtinys bus įjungtas. 

 Spustelėkite Close (užverti). 

 Matavimų geoduomenų bazėje sukurkite naują elementų klasę pavadinimu COGOLines (dešiniuoju 

mygtuku spustelėkite Matavimai.gdb > New > Feature Class). Nurodykite, kad elementai linijiniai – 

Line Features tipo (Type). Erdvinės atramos charakteristikas (Spatial Reference) galima importuoti iš 

vilniusvieLKS94. Kitų parametrų nekeiskite – palikite numatytąsias nuostatas. 

 

10) Sukurkite matavimų duomenų rinkinį (Survey dataset): 

 Dešiniuoju mygtuku spustelėkite Matavimai.gdb, eikite į New ir pasirinkite Survey Dataset… (naujas 

> matavimų duomenų rinkinys). 

 Pavadinkite sukurtą matavimų duomenų rinkinį COGO. Pažymėkite visus matavimų rinkinio 

duomenų tipus. 

 Iš vilniusvieLKS94 importuokite koordinačių sistemą (Coordinate System) ir aprėptį (Domain); 

koordinačių sistema turi atitikti kliento reikalavimus. 

 Nurodykite, kad su matavimų projektais (Survey Projects) reikia susieti tik vilniusvieLKS94 elementų 
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klasę. 

 Baikite kurti matavimų duomenų rinkinį: spustelėkite Finish (baigti). 

Matavimų duomenų rinkinio paruošimas 
 

Kampus ir ilgį ekrane galima rodyti įvairiais matavimo vienetais. Nurodykite, kokius matavimo vienetus naudos 

ArcCatalog programa. 

 

11) Ekrano vienetų nustatymas: 

 Spustelėkite įrankių (Tools) meniu komandą Options (parinktys). 

 Atverkite matavimų formatų (Survey Measurement Formats) skyrelį. 

 Nustatytų formatų (Defined Formats) išskleidžiamajame meniu pasirinkite Angle (kampai). 

 Pažymėkite parinktį Degree-Minute-Second (laipsniai–minutės–sekundės). 

 Pakeiskite tikslumą (Precision) į 0. Mažiausias matavimo vienetas bus sveikos sekundės. 

 Spustelėkite Set As Display Format (nustatyti ekrano formatu). 

 Nustatytų formatų (Defined Formats) išskleidžiamajame meniu pasirinkite Length (ilgis). 

 Metrų (Meters) sąraše pasirinkite ketvirtą poziciją (0.00m) 

 Pakeiskite tikslumą į 2. Mažiausias matavimo vienetas bus sveiki centimetrai. 

 Spustelėkite Set As Display Format (nustatyti ekrano formatu). 

 Spustelėkite OK. 

 

Tas pačias tikslumo vertes vėliau naudosime ir COGO įrašams (kampų tikslumas – sveikos sekundės, ilgio – 

sveiki centimetrai). 

 

Visa matavimų informacija ekrane bus rodoma jūsų nustatytais vienetais. 

 

Matavimų projekto sukūrimas 
 

Matavimų projektas yra matavimų duomenų modelio dalis. Matavimų projektas atitinka konkretų darbą ir 

suteikia loginę struktūrą šio darbo matavimams, taškams, koordinatėms ir skaičiavimams saugoti bei valdyti. 

 

Tai elektroninės ir ant popieriaus surašytos informacijos, gautos ankstesnėje dalyje aprašytais matavimų projekto 

etapais, atitikmuo geoduomenų bazėje. Matavimų projektai yra didesnės duomenų bazės dalis ir skirti matavimų 

procesams valdyti. 

 

Kai vėlesniais lauko matavimais surenkama daugiau duomenų apie tą pačią vietą, šiems duomenims įvesti 

sukuriami papildomi matavimų projektai. 

 

12) Sukurkite matavimų projektą: 

 ArcCatalog lange dešiniuoju mygtuku spustelėkite COGO matavimų duomenų rinkinį ir pasirinkite 

New > Survey Project (naujas > matavimų projektas). 

 Pavadinkite sukurtą matavimų duomenų rinkinį ProjectCOGO. 

 Matavimų projekto projekciją importuokite iš vilniusvieLKS94 elementų klasės (projekcija 

Lietuvos_Koordinaciu_Sistema). 

 Nurodykite tašku atskirtą priešdėlį (Point Prefix): Vilnius. 

 Sutikite su numatytosiomis korekcijų ir KPS matavimų reikšmėmis. 

 Baikite kurti projektą: spustelėkite Finish (baigti). 

 Užverkite ArcCatalog. 
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ArcMap matavimų projekto aplinkos paruošimas 
 

13) ArcMap programa atverkite naują projektą ir įrašykite jį ProjectCOGO.mxd pavadinimu. 

 

14) ArcMap programoje: 

 Spustelėkite Tools (įrankiai) ir Extensions (plėtiniai). 

 Pažymėkite Survey Analyst langelį. Plėtinys bus įjungtas. 

 Spustelėkite Close (užverti). 

 

15) Pridėkite vilniusvieLKS94 ir vilniaus_m_sklypai.shp sluoksnius. Ekrane padidinkite 

vilniaus_m_sklypai.shp sluoksnį. 

 

16) Pažymėkite vilniusvieLKS94 sluoksnį tekstinėmis žymėmis, žymių reikšmes imkite iš PKOD lauko (taško 

kodas; specifikaciją rasite C:\Data\PPDB\_Dokumentacija aplanke, faile Planimetrinio_ 
pagrindo_db_PPDB_LT.doc). 

 

17) Į foną įkelkite 7630.sid aeronuotrauką iš C:\Data\ORT10LT\Vilnius aplanko. 
 

18) Įkelkite savo ProjectCOGO matavimų projektą ir nutempkite jį pele į žemėlapio turinio viršų. Išsaugokite 

žemėlapio dokumentą. 

 

19) ArcMap darbalaukyje atverkite redaktoriaus (Editor) ir matavimų redaktoriaus (Survey Editor) įrankių 

juostas. 

 

20) Naudodamiesi redaktoriaus meniu, pradėkite redaguoti (Start Editing) Matavimai duomenų bazę. 

 

21) Spustelėkite redaktoriaus įrankių juostos redaktoriaus (Editor) išskleidžiamąjį sąrašą ir pasirinkite 

Options… (parinktys). 

 Redagavimo parinkčių (Editing Options) dialogo bendrajame (General) skyrelyje pažymėkite parinktį 

Show snap tips (rodyti pritraukimo užuominas). 

 Vienetų (Units) skyrelyje pakeiskite krypties tipą (Direction Type) į kvadranto orientavimo kampą 

(Quadrant Bearing), krypties vienetus (Direction Units) į laipsnius, minutes ir sekundes (Degrees 

Minutes Seconds). Spustelėkite OK. 

 

22) Redaktoriaus įrankių juostos redaktoriaus išskleidžiamajame sąraše pasirinkite Snapping… (pritraukimas). 

 Pažymėkite  vilniusvieLKS94 viršūnių ir galų pritraukimo langelius. 

 Užverkite pritraukimo parinkčių langą. 

 Dar kartą išsaugokite žemėlapio dokumentą. 

 

23) Po vieną atverkite COGO Points (COGO taškų) ir COGO Measurements (COGO matavimų) savybių 

langus (turinyje spustelėkite dešiniuoju mygtuku ir pasirinkite Properties). 

 

24) Simbolikos (Symbology) kortelėse pažymėkite langelius Show Text (rodyti tekstą) ir pakeiskite teksto 

nuostatas (Text Settings): 

 COGO taškai: teksto žymės laukas (Label Field) bus Name (pavadinimas). 

 COGO matavimai: teksto žymės laukas bus reiškinys (Expression): [Dir] & VbNewLine & [Length]. 

Kad išvengtumėte tikrinimo, spustelėkite OK. Pakeiskite COGO matavimų tekstinių žymių išdėstymo 

parinktį (Label Placement Option) į centravimą ant linijos (Centered on line). Uždarykite langus 

spausdami OK. 

 

25) Išsaugokite žemėlapio dokumentą. 
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Darbas su matavimų projektu  

Geodezinių matavimo ženklų įvedimas į matavimų duomenų rinkinį 
 

Dabar jūsų darbinis projektas yra ProjectCOGO iš COGO duomenų rinkinio. 

 

26) Įveskite COGO geodezinius ženklus (prieš įvedant būtų tikslinga vilniusvieLKS94 sluoksnyje susirasti 

taškus, kurių PKOD reikšmės 05-0282 bei 05-0283, ir priartinti, kad juos gerai matytumėte ArcMap 
žemėlapyje: 

 Redaktoriaus įrankių juostos užduotis (Task) turi būti Create New Feature (sukurti naują elementą), o 

paskirtis (Target) – vilniusvieLKS94. 

 

 Spustelėkite matavimų redaktoriaus (Survey Editor) įrankių paletės rodyklę , išskleidžiamajame 

sąraše pasirinkite bazinių COGO skaičiavimų mygtuką ( , COGO Basic Computations) ir 

spustelėkite XY taško mygtuką (XY Point, ). 

 

 Matavimų tyrimo (Survey Explore) dialoge pavadinkite (Name) šį tašką SP1 (bus prijungtas anksčiau 

nustatytas priešdėlis Vilnius). Spustelėkite Enter (įvesti). 

 

 Nutemkite žymeklį ant vilniusvieLKS94 taško, kurio kodas PKOD = 05-0282, ir pritraukite prie 

įvesto geodezinio ženklo taško (pastebėsite, kad pritraukiant keičiasi paskirties taško spalva). 

Spustelėkite pritrauktą geodezinio ženklo tašką, kad jo koordinatės būtų priskirtos matavimo taškui 

(MT). Užverkite matavimų tyrimo dialogą. 

 

 Pakartokite tuos pačius veiksmus su tašku SP2, imdami vilniusvieLKS94 tašką, kurio kodas PKOD = 

05-0283. Užverkite matavimų tyrimo dialogą. 

 

 Kad pamatytumėte MT tekstines žymes, atnaujinkite (Refresh, ) žemėlapį. Galite ekrane padidinti 

šių taškų sritį. 

 

 Išsaugokite pakeitimus redaktoriaus įrankių juostos redaktoriaus meniu komanda Save Edits (išsaugoti 

pakeitimus). 

 

 Panagrinėkite SP1 ir SP2 taškų X ir Y koordinates: spustelėkite matavimo objektų užklausos 

mygtuką ( , List Survey Objects by Query); kad pamatytumėte SP1 ir SP2 koordinates, 

pažymėkite XY taško (XY Point) langelį ir spustelėkite OK. Palyginkite šias koordinates su 

atitinkamomis X ir Y vertėmis iš vilniusvieLKS94. Jei SP1 ir / arba SP2 koordinatės skiriasi nuo 

atitinkamų vilniusvieLKS94 koordinačių (blogai pritraukta), įveskite šias koordinates iš naujo. 

 

 Išsaugokite žemėlapio dokumentą. 

 

Ėjimų pradžios taško nurodymas COGO skaičiavimais 
 

Pradinis COGO ėjimų skaičiavimo taškas bus 540,22 m atstumu nuo SP2 ir 151,12 m nuo SP1. 
 

27) Atstumų sankirtos (distance-distance intersection) skaičiavimas: 

 Spustelėkite matavimų redaktoriaus įrankių juostos įrankių paletės rodyklę, išskleidžiamajame sąraše 

pasirinkite COGO sankirtų (COGO Intersections) mygtuką ir spustelėkite ėjimų (Traverse) atstumų 
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sankirtos (Dist-Dist-Inter) mygtuką . 

 

 Matavimų tyrimo Survey Explore dialogo lange surinkite pirmojo taško pavadinimą – „SP2“ po 

„Vilnius“, paspauskite įvedimo (Enter) klavišą ir surinkite „540,22“. Dar kartą paspauskite įvedimo 

klavišą. 

 

 Surinkite antrojo taško pavadinimą – „SP1“, paspauskite įvedimo klavišą, antrojo atstumo lauke 

surinkite „151,12“ ir dar kartą paspauskite įvedimo klavišą. 

 

 Pakeiskite sprendinį į dešinįjį (Right) ir paspauskite įvedimo klavišą. Atstumų sankirtos sprendiniai yra 

du. Jei žiūrėtumėte iš pirmojo (SP2) taško į antrąjį (SP1), naujasis taškas bus šiuos taškus jungiančios 

atkarpos dešinėje. Įveskite šį tašką. 

 

 Pavadinkite gautąjį tašką (Result Point) SP3 ir paspauskite įvedimo klavišą (Enter). 

 

 Užverkite matavimų tyrimo dialogą. Išsaugokite pakeitimus redaktoriaus įrankių juostos redaktoriaus 

meniu komanda Save Edits (išsaugoti pakeitimus). 

 

 Kad pamatytumėte SP3 tekstines žymes, atnaujinkite žemėlapį. Išsaugokite žemėlapio dokumentą. 

Ėjimų linijos pradžios taško priskyrimas geodezinių ženklų klasei 
 

28) Dabar iš naujo įskaitmeninsime elementus, pradėdami nuo SP3 matavimo taško: 

 Spustelėkite redaktoriaus įrankių juostos eskizo (Sketch, ) įrankį. 

 

 Spustelėkite užduoties (Task) išskleidžiamojo sąrašo rodyklę ir pasirinkite Create New Feature 

(sukurti naują elementą). 

 

 Paskirties (Target) išskleidžiamajame meniu spustelėkite vilniusvieLKS94. 

 

 Nustumkite žymeklį ant SP3, pritraukite žymeklį prie taško (šviesiai mėlyna spalva rodo, kad 

žymeklis pritraukiamas) ir spustelėkite SP3 tašką. 

 

 Išsaugokite pakeitimus atitinkama redaktoriaus įrankių juostos redaktoriaus meniu komanda. 

 

 Išsaugokite žemėlapio dokumentą. 

 

Dabar mes turime sklypo dalijimo COGO ėjimų linijos pradžios tašką SP3. 

 

COGO ėjimų formavimas 
 
Ėjimų metodas – tai toks matavimų būdas, kai pradedama matuoti nuo žinomo taško, toliau matavimo prietaisai 

statomi keliuose nežinomuose tarpiniuose taškuose, ir baigiama matuoti žinomame galiniame taške. 

Išmatuojamas kiekvieno ėjimo ilgis, o kiekviename matavimo taške išmatuojamas kampas. Autonominiais 

elektroniniais tolimačiais ar teodolitais gaunami dvimačiai ėjimai. Elektroniniais tacheometrais galima gauti 
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trimačius ėjimus. 

COGO įvedimas iš užsakovo plano 
 

Brėžinys, pagal kurį reikės dalinti sklypą, yra faile Sheet_1.jpg, o atitinkami matavimai – faile Sheet_1.dbf. 
Sheet_1.jpg galima atverti ir atspausdinti bet kuria vaizdų peržiūros programa. Kad pamatytumėte išmatuotus 

orientavimo kampus ir atstumus, ArcMap programa atverkite Sheet_1.dbf. Sheet_1.dbf OBJECTID lauko 

skaičiai atitinka Sheet_1.jpg ėjimų šonuose sužymėtus skaičius. 

 

29) COGO ėjimų įvedimas iš Sheet_1 matavimų: 

 Iš Matavimai.gdb į žemėlapį įkelkite COGOLines elementų klasę. 

 

 Užduoties (Task) išskleidžiamajame sąraše pasirinkite Create New Feature (sukurti naują elementą). 

 

 Paskirties (Target) išskleidžiamajame sąraše pasirinkite COGOLines. 

 

 Pridėkite COGO įrankių juostą (View > Toolbars > COGO – rodymo meniu > įrankių juostos > 

COGO) ir spustelėkite ėjimų (Traverse) mygtuką . 

 

 Atsidariusiame ėjimo (Traverse) dialogo lange nurodykite ėjimų pradžios tašką ( ): pritraukite 

(pritraukiant rodoma pritraukimo užuomina) SP3 pradinį geodezinį tašką ir paimkite jo 

koordinates.  

 

 Pažymėkite langelį Close Loop (uždara kilpa). 

 

 Pradėkite įvedinėti sklypo dalinimo ėjimus (stora linija Sheet_1 brėžinyje). Įvedamus duomenis ir 

atskaitos sistemą imkite iš Sheet_1 brėžinio ir Sheet_1.dbf COGO matavimų lentelės. Brėžinio 

tekstinės žymės atitinka Sheet_1.dbf OBJECTID lauko reikšmes. Skersinės linijos bus 

skaitmeninamos vėliau. 68-69 ir 52-53 skersines linijas galima pridėti kaip trumpus ėjimus COGO 

įvesties būdu. Sheet_1.dbf matavimus galima nukopijuoti ir įdėti į ėjimų (Traverse) dialogo teksto 

langelius. Vieno iš įrašų pavyzdys: 
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 Kartkartėmis įrašykite sukurtus ėjimus į teksto failą: dešiniuoju mygtuku spustelėkite COGO sąrašą ir 

įvykdykite komandą Save Traverse (išsaugoti ėjimus). Iš šio failo galima bet kada įkelti ėjimus (Load 

Traverse). 

 
 

3 klausimas. Ką reiškia COGO? Kas yra COGO? 

 

 

 

 

 

 

1 

Ėjimų atkarpą galite nurodyti įvairiomis krypčių, kampų ir apskritimo lankų parametrų kombinacijomis: 

 

Patarimai: Jei norite prie sukurtų ėjimų pridėti naują atkarpą, įveskite atkarpos tipo parametrus ir spustelėkite 

mygtuką Add (pridėti) arba paspauskite įvedimo klavišą. Krypties tipas ir matavimo vienetai nurodyti per 

redaktoriaus išskleidžiamąjį sąrašą atveriamo redagavimo parinkčių (Editing Options) dialogo vienetų 

(Units) skyrelyje. Jei nenustatyta kitaip, atstumai ir ilgiai rodomi žemėlapio vienetais. Bet galima 

nurodyti kitus matavimo vienetus – reikia kartu su verte įrašyti vieneto santrumpą, pavyzdžiui, 10 metrų 

– "10m". Daugiau informacijos apie COGO aprašus rasite adresu 

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=About_COGO_descriptions 

 

Krypties ir atstumo (Direction-Distance) įrankis: prie ėjimo prideda tiesią atkarpą, nurodomą kryptimi ir 

atstumu. Kryptį jums reikės nurodyti orientavimo kampu kvadrantų azimuto (Quadrant Bearing) 

 

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=About_COGO_descriptions
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sistemoje (pvz., S20-25-45E). 

 

Kampo ir atstumo (Angle-Distance) įrankis: prie ėjimų prideda tiesią atkarpą, nurodomą kampu nuo ankstesnės 

krypties ir atstumu. Kampu ir atstumu nurodyta atkarpa negali būti pirmoji ėjimų atkarpa, nes jos kryptis 

priklauso nuo ankstesnės atkarpos. 

 

Kreivės (Curve) įrankis: prie ėjimų prideda kreivės segmentą..Kreivė gali būti arba tangentinė (liestinė), arba 

radialinė – šiuo atveju nurodoma kryptis į lanko centrą arba stygos kryptis. 

 

  
 

Liestinės kreivės (Tangent Curve) įrankis: prie ėjimų prideda kreivę, tangentinę ankstesniajai atkarpai. Galima 

nurodyti šiuos kreivės parametrus: stygos ilgį (Chord), spindulį (Radius), lanko centrinį kampą, dar 

vadinamą delta kampu (Angle), ir lanko ilgį (Arc). Posūkio parametras nurodo, ar kreivė linksta kairėn, ar 

dešinėn. Liestinės kreivės ėjimo atkarpa negali būti pirmoji ėjimų atkarpa, nes jos kryptis priklauso nuo 

ankstesnės atkarpos. 

Jei neįjungtas atkarpų (Course) sąrašas, patikrinkite, ar nustatytos pradžios koordinatės ir ar paskirtis yra linijinė 

arba poligoninė elementų klasė. 

 

Jei neleidžiama komanda Add, patikrinkite, ar teisingos įvestos krypčių, kampų ir atstumų vertės. 

 

30) Jei reikia, įvestas vertes galima pataisyti – reikia dukart spustelėti atitinkamo ėjimų segmento įrašą ir iš 

naujo įvesti vertes. Palyginkite sukurtus įrašus ir ArcMap žemėlapį su originaliu brėžiniu. Patikrinkite 

tarpinių segmentų padėtis ir kryptis. Jei yra klaidų, tarpinius įrašus galima pakeisti, įterpti, pašalinti arba 

perkelti. 

 Kai baigsite ėjimų liniją, pirmiausia ją išsaugokite (!): dešiniuoju mygtuku spustelėkite ėjimų sąrašą 

ir įrašykite ėjimus (Save Traverse) į tekstinį failą. 

 Patikrinkite uždarymo (nesąryšio) parametrus: spustelėkite mygtuką Closer (uždarymas). Jei įvesti 

tinkami duomenys, atstumo uždarymo paklaida neturi viršyti 1 metro. Padarykite šios ataskaitos 

ekrano nuotrauką ir pateikite vertinimui (žr. 10 klausimą). 

 Jei atstumo uždarymo klaida didesnė negu 1 metras, pabandykite surasti ir ištaisyti įrašo (-ų) klaidą (-

as). 

 Jei atstumo uždarymo klaida mažesnė už 1 metrą, išlyginkite (Adjust) ėjimą pagal kompaso taisyklę 

(Compass Rule). 

 

31) Sukurkite atvirus 68-69 ir 52-53 skersinių sklypo linijų ėjimus COGO įvesties būdu: 

 Redaktoriaus (Editor) įrankių juostos redaktoriaus (Editor) išskleidžiamajame sąraše pasirinkite 

Snapping… (pritraukimas). 

 Pažymėkite COGOLines viršūnių ir galų pritraukimo langelius. 

 Užverkite pritraukimo parinkčių langą. 

 Pradėdami nuo tarpinių ėjimų kontūro viršūnių, COGO įvesties būdu sukurkite 68-69 ir 52-53 

skersines linijas. Pritraukite skersinių linijų ėjimų pradžios ir pabaigos taškus prie ėjimų kontūro 

viršūnių. 

 

32) Dabar turite dalinimo plano kontūrą – vieną poliliniją su viršūnėmis. 

 Išsaugokite pakeitimus redaktoriaus įrankių juostos redaktoriaus meniu komanda Save Edits 

 

Tangentinė 

Radialinė 

Styga 

Lankas 

Styga 

Spindulys 
Kampas 
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(išsaugoti pakeitimus). 

 Išsaugokite ir ArcMap žemėlapio dokumentą. 

4 klausimas. Kas yra kompaso taisyklė? 

 

 

 

 

 

 

2 

Tiesių segmentų suformavimas iš polilinijos ir skersinių eskizo linijų 
 

Dabar turime ėjimų poliliniją, bet kiekvieno linijos segmento COGO skaičiavimams mums reikia tiesios linijos, 

nurodomos 2 taškais. 

 

33) Iš COGOLines polilinijos gaukite tiesias linijas: 

 Pažymėkite visą COGOLines poliliniją: atverkite COGOLines atributų lentelę >Options > Select All 

–parinktys > pažymėti viską). Ją pažymėti galima ir elementų pasirinkimo (Selection Features) įrankiu 

. (Patarimas: jei reikia, panaikinti pažymėjimą galima elementų atžymėjimo (Clear Selection 

Features) įrankiu ). 

 

 COGO įrankių juostos skaidymo į COGO linijas (Split into COGO lines, ) įrankiu iš polilinijos 

sukurkite tiesias linijas. 

 

35) Pagal Sheet_1 brėžinį nubrėžkite skersinių COGOLines linijų eskizą ( ): 

 Redaktoriaus (Editor) įrankių juostos redaktoriaus (Editor) išskleidžiamajame sąraše pasirinkite 

Snapping… (pritraukimas). 

 Pažymėkite COGOLines viršūnių ir galų pritraukimo langelius. 

 Užverkite pritraukimo parinkčių langą. 

 Spustelėkite užduoties (Task) išskleidžiamojo sąrašo rodyklę ir pasirinkite Create New Feature 

(sukurti naują elementą). 

 Spustelėkite paskirties (Target) išskleidžiamojo meniu rodyklę ir pasirinkite COGOLines. 

 Eskizo (Sketch) įrankiu pritraukite ir nubrėžkite COGOLines skersines linijas. 

 Išsaugokite pakeitimus redaktoriaus įrankių juostos redaktoriaus meniu komanda Save Edits (išsaugoti 

pakeitimus). 

 Baikite redagavimo seansą: redaktoriaus (Editor) įrankių juostos redaktoriaus (Editor) meniu 

pasirinkite komandą Stop Editing (baigti redaguoti). 

 Išsaugokite (Save) ArcMap dokumentą. 

 

Dabar turite užbaigtą dalinimo eskizą. 
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Dalijimo plano elementų klasės COGO atributų skaičiavimas 
 

Dabar jums reikia sukurti naujus COGOLines COGO laukus. Šiuose laukuose bus daugiausia COGO aprašai, 

pavyzdžiui, atstumai, išmatuoti kampai ir kreivių parametrai. 

 

36) Naujų COGOLines COGO laukų kūrimas: 

 Išsaugokite savo ProjectCOGO.mxd projektą ir užverkite ArcMap. 

 

 Atverkite ArcCatalog. ArcCatalog lange dešiniuoju mygtuku spustelėkite standartinių įrankių juostą. 

. 

 

 Pasirinkite Customize (pritaikyti). Spustelėkite komandų (Commands) skyrelį. Show commands 

containing (rodyti komandas, turinčias) langelyje surinkite "COGO Fields". Dešinėje polangio pusėje 

pasirodys esami geoduomenų bazės įrankiai. 

 

 Pele nutempkite COGO laukų kūrimo mygtuką (Create COGO Fields, ) ant bet kurios ArcCatalog 

įrankių juostos . Užverkite Customize (pritaikyti) dialogą. 

 

 ArcCatalog katalogo (Catalog) medyje pažymėkite COGOLines linijinių elementų klasę ir 

spustelėkite nutemptąjį COGO laukų kūrimo mygtuką. Pasirodys pranešimas, kad laukai buvo pridėti. 

Pridėtus laukus galima pamatyti ArcCatalog peržiūros (Preview) skyrelyje, pasirinkus Preview: Table 

(peržiūrėti: lentelę). 

 

 Užverkite ArcCatalog ir vėl atverkite ProjectCOGO.mxd projektą ArcMap programa. Kai kurių 

veiksmų su tais pačiais duomenimis neįmanoma atlikti ArcCatalog ir ArcMap programomis vienu 

metu. 

 

37) Apskaičiuokite COGOLines COGO matavimus: 

 ArcMap programoje atverkite COGOLines atributų lentelę ir pašalinkite du laukus – krypties 

(Direction) ir centrinio kampo Delta (dešiniuoju mygtuku spustelėkite failo antraštę ir pašalinkite 

lauką (Delete Field)). Jums reikia iš naujo sukurti šiuos laukus su kitais parametrais: spustelėkite 

parinkčių (Options) meniu komandą Add Field (pridėti lauką), pridėkite tekstinį (text) 50 ženklų ilgio 

(length) lauką ir pavadinkite jį Direction. Atlikdami tuos pačius veiksmus, pridėkite lauką Delta. 

 

 Pradėkite redaguoti COGOLines ir pažymėkite visas COGOLines linijas. 

 

 Spustelėkite COGO įrankių juostos mygtuką  Update COGO Attributes (atnaujinti COGO 

atributus). Įrašant krypties ir kampų atributus į lentelę, naudojamos einamosios krypties tipo ir kampų 

vieneto reikšmės. Įrašant atstumų atributus, naudojami einamosios koordinačių sistemos ilgio vienetai. 

 

38) Dabar jums reikia COGOLines mazguose sukurti taškinius elementus. 
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 ArcToolbox elementų klasių konvertavimo į ARC/INFO sluoksnius (Feature Class to Coverage) 

įrankiu konvertuokite COGOLines į ARC/INFO sluoksnį (coverage) 

(http://support.esri.com/index.cfm?fa=knowledgebase.gisDictionary.search&search=true&searchTerm

=coverage ). 

 

 Pavadinkite gautą sluoksnį COGO1 ir įrašykite į aplanką, kurio kelyje nėra specialiųjų ženklų ir 

tarpų. Kiekvieno aplanko pavadinimas turi būti ne ilgesnis negu 8 simbolių. 

 XY tolerancija (XY tolerance) 0,00001, o vienetai (Units) – metrai. 

 Pažymėkite langelį Double Precision (dvigubas tikslumas). 

 Nustatykite šias sluoksnių nuostatų (Coverage Settings) aplinkos kintamųjų (Environment) 

reikšmes: išvestinių sluoksnių tikslumas – aukščiausias (Precision for Derived Coverages – 

Highest); naujų sluoksnių tikslumas – dvigubas (Precision for New Coverages – Double), 

projekcijų failų palyginimo lygmuo – išsamus (Level of Comparison between Projection Files – 

Full). 

 Įvykdykite konversiją. 

 

 Paleiskite ArcToolbox valymo (Clean) įrankį. Valymo įrankis sukuria ARC/INFO sluoksnį su teisinga 

poligonų arba kreivių-mazgų topologija. Jis pataiso geometrines koordinačių klaidas, iš lankų sukuria 

poligonus ir kiekvienam poligonui ir lankui sukuria atributinę informaciją. 

 Pavadinkite naują ARC/INFO sluoksnį COGO2. 

 Pasirinkite POLY elementų tipą. 

 

 NODE elementų tipui sukurti paleiskite ArcToolbox formavimo (Build) įrankį. Formavimo įrankis 

sukuria arba atnaujina elementų atributų lenteles ir poligonų topologiją. Šiuo atveju formavimo įrankis 

COGO2 sluoksnyje sukuria mazgų elementus. 

 

 Įkelkite COGO2 mazgus ( ) į ArcMap: dukart spustelėkite COGO2 ir pasirinkite mazgą (node) 

 iš ARC/INFO sluoksnio rinkinio. Perspėjimo dėl koordinačių sistemos (Coordinate 

System Warning) nepaisykite – užverkite langą (Close). 

 

 Eksportuokite gautą mazgų sluoksnį į Matavimai.gdb kaip naują elementų klasę pavadinimu 

COGOPoints. Įsitikinkite, kad jos geografinio orientavimo parametrai yra tokie, kokius nurodė 

klientas: dešiniuoju mygtuku spustelėkite cogo2 node sluoksnį, eikite į > Data > Export Data 

(duomenys > eksportuoti duomenis), pasirinkite sluoksnio duomenų srities („the data frame“) 

koordinačių sistemą, eikite į Matavimai.gdb ir pavadinkite šią taškinių elementų klasę COGOPoints. 

 

 Išsaugokite žemėlapio dokumentą ir užverkite ArcMap. 

 

39) ArcCatalog programa paruoškite Matavimai duomenų bazę klientui – pašalinkite iš jos tarpinę elementų 

klasę ir  projektą (prieš išvalydami duomenų bazę, galite pasidaryti atsarginę kopiją). Klientui reikia tik 

 COGOLines ir COGOPoints elementų klasių. 

 

40) Pateikite rezultatus klientui (žr. 9 klausimą). 

http://support.esri.com/index.cfm?fa=knowledgebase.gisDictionary.search&search=true&searchTerm=coverage
http://support.esri.com/index.cfm?fa=knowledgebase.gisDictionary.search&search=true&searchTerm=coverage
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5 klausimas. Kaip COGO susijusi su CAD, GIS, ir inžinerinių uždavinių sprendimo programine įranga? 

 

 

 

 

 

 

 

1 

6 klausimas. Kas naudoja COGO? 

 

 

 

 

 

 

1 

7 klausimas. Kaip vykdoma COGO? 

 

 

 

 

 

 

1 

8 klausimas. Kokie žemėlapių, sukurtų COGO įvesties būdu, pranašumai ir trūkumai? 

 

 

 

 

 

2 

9 klausimas. Pateikite galutinę matavimų duomenų bazę (Matavimai) su COGO. 5 

10 klausimas. Pateikite nesąryšio ataskaitą. 3 
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PRIEDAS 

Koordinačių sistemos Pulkovo 1942 (SD42) LKS-94 

Projekcinė koordinačių 

sistema 

 Projekcija: Gauso-Kriugerio 

 Zona: 5 

 Ilgumos poslinkis: 500000 

 Platumos poslinkis: 0 

 Ašinis dienovidinis: 27 

 Mastelio koeficientas: 1 

 Pradinė platuma: 0 

 Ilgio vienetas: metras 

 Projekcija: skersinė Merkatoriaus 

 

 Ilgumos poslinkis: 500000 

 Platumos poslinkis: 0 

 Ašinis dienovidinis: 24 

 Mastelio koeficientas: 0,9998 

 Pradinė platuma: 0 

 Ilgio vienetas: metras 

Geografinių 

koordinačių sistema: 

 Kampų matavimo vienetas: laipsnis 

 Pradinis dienovidinis: Grinvičo 

 Elipsoidas: Pulkovo 1942 

 Sferoidas: 1940 m. Krasovskio 

 Didžioji pusašė: 6378245,0 

 Mažoji pusašė: 6356863,01877304730 

 Atvirkštinis paplokštumas: 

298,300000000000010 

 Kampų matavimo vienetas: laipsnis 

 Pradinis dienovidinis: Grinvičo 

 Elipsoidas: Lietuvos 1994 m. 

 Sferoidas: GRS_1980 

 Didžioji pusašė: 6378137,0 

 Mažoji pusašė: 

6356752,31414035610 

 Atvirkštinis paplokštumas: 

298,257222101000020 

 


